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VISION OF THE INSTITUTION 

 

To establish a unique identity of a pioneer technical Institute by developing a high-

quality technical manpower and technological resources that aim at economic and 

social development of the nation as a whole and the region, in particular, keeping 

in view the global challenges. 

 

 

 

 

MISSION OF THE INSTITUTION 

 

M1.  To create a strong and transformative technical educational environment in 

which fresh ideas, moral principles, research and excellence nurture 

with international standards. 

M2.   To prepare technically educated and broadly talented engineers, future 

innovators and entrepreneurs, graduates with understanding of the needs and 

problems of the industry, the society, the state and the nation. 

M3.   To inculcate the highest degree of confidence, professionalism, academic 

excellence and engineering ethics in budding engineers. 

 

 

 

 

 

 

 

 



 

 

NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

HAZRATBAL, SRINAGAR- 190006 (J&K) 
 

 

DEPARTMENT OF CIVIL ENGINEERING 

 

 
VISION OF THE DEPARTMENT 

 

To create a unique identity of the Department by achieving excellent 

standards of quality technical education keeping pace with the rapidly 

changing technologies and to produce Civil Engineers of global 

standards with the capability of accepting new challenges. 

 

 
MISSION OF THE DEPARTMENT 

 

M1.    To promote academic growth in the field of Civil Engineering 

by offering state-of-the art undergraduate and postgraduate 

programmes.         

M2.    To provide knowledge base and consultancy services in all areas 

of Civil Engineering for industry and societal needs.    

M3.    To inculcate higher moral and ethical values among the students 

to become competent Civil Engineers with overall leadership 

qualities.      

M4.   To flourish as the Centre of Excellence in the emerging areas of 

research related to Civil Engineering and its allied fields.  

 



NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

Name of Department: Department of Civil Engineering 

1. Subject Code: CIV-705    2. Course Title: Computer Aided design (CAD) 

3. Relative Weightage: Minor: 30;  CA: 10;  Major: 60       4. Contact Hours: L: 1 T: 1 P: 3 

5. Credits: 03   6. Semester: Autumn    7. Pre‐requisite: Nil 

 

8. Objective: To introduce students to various application software(s) related to Civil Engineering so 

that they can find the applicability of one (or more) in their project work. 

 

Details of the Course: 

Introduction: Introduction to hardware, software, storage devices and operating systems; Difference 

and link between system software and application software; Historical development of computer 

languages; Previous interfaces and  Graphical User Interface (GUI); Binary system; file types and various 

extensions; Classification of the software(s). 

AutoCAD: Introduction to AutoCAD 2017 user interface;Templates; basiccommands;Tabs,panels and 

ribbons; Edit/Modify Objects commands; View Objects commands; Selection methods; Accuracy in 

drafting; Grips; units; Snap and Grid; Inquiry commands; understanding layers and their attributes; 

linetypes; Match Properties; Text and Mtext; Hatch fundamentals; Gap tolerance; Gradients and solid 

fills; Dimensions; Creating and working with blocks and wblocks; Purge; Creating a polar array, 

rectangular array and path array; Printing and Plotting in AutoCAD; Isometry in Auto CAD. 

Surfer and SPSS: Introduction to Surfer; working in plots and worksheets; tabs in surfer- file, edit, draw, 

grid etc.; customizable maps- base maps, contour maps,  wireframes, etc.; working with graphs; 

exporting and importing files to other softwares.Introduction to SPSS; working with data view; working 

with variable view; analysis of the data- mean comparison, correlate, regression; chart builder. 

MATLAB: Introduction to MATLAB; its uses and application in Civil Engg.; introduction to workspace and 

command window, machine learning; data normalization in MATLAB; constructing a network, training 

the network, simulation, post-training analysis and validation.      



LECTURES-Main Points/ Headings 

VIEWING TOOLS 

1. Zoom 

2. Regen  

3. Pan  

SELECTION METHODS 

4. Crossing - green 

5. Window – blue 

6. Lasso function – crossing and window 

 

DRAWING AIDS AND ACCURACY 

1. ORTHO (F8) 

2. OSNAP 

GRIPS 

UNITS- using architectural system  

SNAP AND GRID 

Dynamic input mode- automatically tells us the details about distance and angles 

Use of tab key in DYNMODE 

Manual mode- (x,y) and @length<angle 

Difference between the Dynamic Mode and Manual Mode 

Inquiry Commands  

• Area 

• Distance 

• List-info about the object 

• ID- point location 

• Radius 

• Angle 

 



More Drafting Commands  

Explode      Time     join     

Exercises 

1. Draw a STAR (T) 

 

 

 

 

 

2. Draw a three legged intersection (T) with following details: (T) 

Road A= 15m width (divider/median=3m) 

RoadB= 7m 

Make conflict point diagram 

Show cross conflicts by red circles 

Diverging conflicts by blue rectangles 

Merging conflicts by yellow triangles 

The connection should not be sharp 

 

 

 

 

 

15 units 



LECTURE 

 

1. Layers: why layers? creating new layers; setting attributes; 

Freeze/ thaw; on/off; lock/unlock; using layer toolbar 

2. Use of LW command 

3. Use of LINETYPE 

4. Use of LTSCALE 

5. Introduction to Properties, Quick Properties and Match 

Properties 

 

  



Practice drawings/ Assignments 

Q: Assignment for students with their roll numbers as prime 

number. (T) 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



Q: Assignment for students with their roll numbers as even numbers 

but not prime.(A) 

 

  



Q: Assignment for students with their roll numbers as odd numbers 

but not prime.(A) 

            

            

            

            

            

            

            

            

            

            

            

            

            

            

            

            

            

          



LECTURE 

Working with: 

1. SKETCH  

2. ARC TEXT 

Class Assignment: (T) 

Q: Draw the following logo in AutoCAD 2017 with precision (T) 

 

 

 Assignment: (A) 

Q: Design a logo for Civil Engg. Dept. (NIT Srinagar) using 

AutoCAD 2017. 



LECTURE 

TEXT: 

➢ TEXTEDIT/ DDEDIT 

➢ %%p, %%u, %%c, %%d    (use in the prefix) 

• Text is used mostly when only one or a few lines are needed. 

• The text cannot be formatted nor any effects added, beyond 

underlining and a few other minor effects. 

• Multiple lines of text are not in paragraph form, rather they 

remain individual lines. 

 

MTEXT 

➢ MTEXTEDIT 

➢ MText edit toolbar and Character map 

 

• Used primarily for writing paragraphs. 

• Has extensive formatting and editing features. 

• Has an extensive symbol library and spell check. 

• Can accept extensive text importing. 

 

Use of NEAREST OSNAP – a misnomer 

 

Class  (T) 

Q: Make a professional title box for your drawing using TEXT 

and MTEXT commands and analyse the difference between the 

two. 



Q: Make a legend/ symbol box with description showing 20 

different symbols used in Civil Engineering discipline.(T) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



LECTURE 

 

Working with HATCH 

Step 1. Pick the hatch pattern you want to use. 

Step 2. Indicate where you want the pattern to go. 

Step 3. Fine-tune the pattern by adjusting scale and angle (if required). 

Step 4. Preview the pattern and accept it if OK. 

 

HATCHEDIT 

Why Associative? Give examples with and without associative option. 

GAP TOLERANCE values in Hatch Edit Options 

 

GRADIENT  

BOUNDARY 

 

  



Q: For even consoles.(A2) 

              

              

              

              

              

              

         



Q: For odd consoles.(A2) 

 

 



LECTURE 

Working with Dimensions 

Primary dimensions are the dimensions used most often by the typical 

architectural or engineering designer: 

● Linear (horizontal and vertical) 

●Aligned 

● Diameter 

● Radius 

● Angular 

● Continuous 

● Baseline 

● Leader 

Commands: DIM, QDIM, DIMCONTINUE, DIMBASELINE 

MULTILEADER,  

MLEADERSTYLE > modify> content> multileader type> block 

Other functions overview 

 

Secondary dimensions are: (Give examples) 

● Arc length 

● Jogged 

● Jogged linear 

● Ordinate 

 

Editing dimensions 

DIMSTYLE, DDEDIT 



Center Marks and CenterLines:CENTERMARKEXE, 

CENTERLTYPE, CENTERLAYER, and CENTERLTSCALE 

Q: Class  Tutorial          

             

             

  

 

 

 

 

 



LECTURE 

BLOCK is a collection of objects that are grouped and held together 

under some identifyingname. 

Concept: 1. Reuse 

        2. Symbol libraries 

Working withBLOCKS: (Command:  “BLOCK”) 

➢ Creating a Block 

➢ Inserting a Block (Command:  “INSERT”) 

Purge- to clean up permanently 

(Command:  “PURGE”) 

OR 

File> Drawing Utilities> Purge 

Two main points to remember are: 

• Purge does not get rid of objects that are visible and present in the 

drawing - it is not an erase command. 

• Purge is permanent (unless you immediately undo it), so be careful of 

what you purge. If you anticipate eventually needing something, do not 

purge it out. 

Write Blocks – the only exception is that it is stored externally into the file 

(Command:  “WBLOCK”) 

INSERT > Browse 

Dynamic Blocks: Three thingsmake up a dynamic block:  

1. Geometry  

2. Parameter (at least one)- defines features 



3. Action associated with that parameter (at least one)- defines 

modification 

Block Editor(Command:BEDIT) 

Visibility in blocks (multiple visibilities) - give examples by making 

different geometric shapes and change their visibility states 

Parameter> Visibility> Visibility state (Ribbon)> Rename and add all the 

shapes> Drop down menu (active state)> make all other invisible 

(Command: “BVHIDE”) 

 

Working with GROUPS 

➢ Quick properties in GROUPS 

➢ Group Selection ON/ OFF 

OR 

(Command: “PICKSTYLE”) 

➢ Ungroup:(Command: “UNGROUP”) 

➢ Group edit:(Command: “GROUPEDIT”): Add/ Remove/ Rename 

Group 

➢ Group Manager:(Command: “CLASSICGROUP”) 

 

Assignment  

Q: Draw 20 different blocks which are required time and again in Civil 

Engineering drawings. Try out all the three options and analyse the 

difference between the three. 

Q: What are the various merits and demerits of GroupsoverBlocks? 

 

  



LECTURE 

ARRAYS 

Definition: Arrays are very useful tools in AutoCAD to create 

patterns of objects. 

Types of Arrays: 1. Polar Array 

      2. Rectangular Array 

   3. Path Array 

POLAR ARRAY:  

A polar array is a collection of objects around some common point 

arranged in a circle (or part thereof). 

Fourcritical items required to create a polar array: 

1. What object(s) to array 

2. The centre point of the array 

3. How many objects to create (six, seven or ten) 

4. If the pattern goes all the way around (i.e., is it 360° or less) 

Creating a Polar Array 

Command: “ARRAYPOLAR” 

Grips in Array 

Items, Rows, Levels, Properties and Options/ Close Array 

(Explain each function with examples) 

Command: “ARRAYCLASSIC”- feel of older AutoCAD versions 

(Create an array using  classic mode) 

 

 



RECTANGULAR ARRAY 

A rectangular array replicate objects in rows (horizontal) and 

columns (vertical). 

Three critical items required to create arectangular array: 

1. What object(s) to array 

2. How many rows and columns to create 

3. Distance between the rows and the columns 

Creating arectangular array 

Command: “ARRAYREC” 

Columns, Rows, Levels, Properties and Options/ Close Array 

Command: “ARRAYCLASSIC”- feel of older AutoCAD versions 

(Create an array using  classic mode) 

 

PATH ARRAY 

A path array creates a pattern along any predetermined pathway, of 

any shape, as opposed to a strictlycircular or linear one. 

Three critical items required to create a path array: 

1. What object(s)to array 

2. The path 

3. How many objects to create 

Creating a Path Array 

Command: “ARRAYPATH” 

Items, Rows, Levels, Properties and Options/ Close Array 

 



Practice drawings 

Q1: Draw the following five row by five column rectangular array. 

The chairs are 20" by 20" and the offset between them is 50". The 

array is also at a 45° angle. 

 

 

 

 

 

 

 

 

 



Q2: Draw the following seven rows by six column rectangular 

array, including the centerline grid and the grid lettering and 

numbering. The I-beams and the offset between them can be of any 

appropriate size, but approximate everything to look like the image 

shown. 

 

 

 

 

 



Q3: In a new file, draw the following polar array, made up of a 

table, chairs, and computers. No sizing is given and all elements can 

be approximated. Place each element on the appropriate layer, and 

make a block out of it prior to using it in the array. 

 

 

 

 

 

 

 



Q4: In a new file, draw the following gear array. Begin with circles 

of the indicated diameter. Then, focus on creating the first tooth, as 

seen in the detail. Make sure it is centered and aligned. Finally, 

array the tooth (24 teeth are used in the example) and clean up the 

design with trimming. The final result follows. 

 

 

 

 

 

 



LECTURE 

PRINTING AND PLOTTING AUTOCAD DRAWINGS 

➢ ESSENTIALS FOR PRINTING OR PLOTTING: 

1. What printer or plotter to use? 

2. What paper size to use? 

3. What area to plot? 

4.At what scale to plot? 

5. What pen settings to use? 

6. What orientation to use? 

7. What offset (if any) to use? 

1. What printer or plotter to use? 

Printer or plotter (depends on number of factors) 

2. Some basic sized papers: 

● A size: 11″ × 8.5″ sheet of paper (letter). 

● B size: 17″ × 11″ sheet of paper (ledger). 

● C size: 22″ × 17″ sheet of paper. 

● D size: 36″ × 24″ sheet of paper. 

● E size: 48″ × 36″ sheet of paper. 

➢ Difference between printing and plotting 

Printing usually refers to the output of drawings on A- or B-sized 

paper, which is easily done on most office LaserJetprinters. Plotting 

usually refers to output of drawings on C-, D-, or E-sized paper, 

which has to be done on plotters. 



3.What Area to Plot? 

Extents: Prints what AutoCAD sees (not necessarily what you see) 

Tip: Use zoom>extents 

Be aware: Freeze, Defpoints, etc. (layers) 

Window 

Display  

Limits 

4. At what scale to plot? 

5. What pen settings to use?(Pencils- 2H, 4H, etc.) ~ professional 

look 

6. What orientation to use?(portrait or landscape) 

7. What offset (if any) to use?(x=? and y=? OR Center the plot) 



➢ Importance of option “Preview” 

➢ PAGE SETUP MANAGER 

Output tab (ribbon)> Page setup manager 

Create a new setup. Merits of using “import”. 

(Give examples to illustrate by switching between the drawings) 

 

Class Assignment: 

Q: Draw margins and a title box in the layout tab. The drawing 

(e.g. a floor plan) should be made in model tab. Then try out 

different options available under “Plot”. 

(try to give a demo) 

 

 

 

 

 

 

 

 

 

 

 

 



LECTURE 

ISOMETRIC DRAWING IN AUTOCAD 

Definition: Isometric perspective means representing a three-

dimensional object in two dimensions. 

Q: What is the difference between Isometric and Axonometric 

drawings? 

 

Assignment Question: 

Q: When to use isometry over 3D drawing? 

Q: When not to use isometry over 3D drawing? 

 

➢ Basic Concept of Isometry 

Rule of 30○-60○-90○ 

Tip 1:Switching between the planes- F5 key 

 

Tip 2: Set your cursor to 100% for better visualisation of planes. 

Tip 3: Have ORTHO on always when using isometry. 



Tools> Drafting Settings> Snap and Grid Tab> Isometric Snap 

➢ Ellipse for circles 

➢ Text:  

Tip: Format> Text Style(if Cascading Menu is hidden go to  in 

the top left and click on show menu bar) 

Use negative 30 for other plane. Make sure you rotate the text 

30○and 330○respectively. 

 

 

 

 

 

 



 

Assignments 

Q: Try the following isometric drawings in AutoCAD. Estimate the 

dimensions but make sure it looks alike the drawings shown. 

 



 

 



Q: Draw the computer table that you are using in CAD Lab along 

with all the accessories (monitor, CPU, notebook, etc.) 

LECTURE 

3D BASICS IN AUTOCAD 

➢ Concepts: 

 

Axes, Planes and Faces 

➢ 3D Workspaces, Ribbon, Toolbars, and 3DOptions 

Choose 3D Modeling from drop-down menu (currently set as 

Drafting and Annotation) 

[For now] using Tools→Toolbars→AutoCAD in the cascading 

menus, bring up the following toolbars: 



View 

3D Navigation 

Visual Styles 



NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

Department of Civil Engineering 

Subject Code: CIV-705     Course Title: Computer Aided design (CAD) 

Tutorial 1 

1. Draw a perfect five-sided star shown below using basic 

commands in AutoCAD. 

 

2. Draw a three legged (T) intersection with the following details: 

• Road A= 15m width (divider/median=3m) 

• RoadB= 7m 

Make conflict point diagram. 

Note:  1. Show cross conflicts by red circles, diverging conflicts by blue rectangles and merging conflicts 

by yellow triangles. 

2. The connection should not be sharp. 

3.  Draw the following floor plan. Try different layers and analyze the difference.  

 

15 units 



NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

Department of Civil Engineering 

Subject Code: CIV-705     Course Title: Computer Aided design (CAD) 

Tutorial 2 

1.  Working with SKETCH and ARCTEXT commands along with other basic commands, draw the following 

logo in AutoCAD with precision. 

 

 

 

 

 

 

2. Make a professional title box for your drawing using TEXT and MTEXT commands and analyze the 

difference between the two. 

3. Make a legend/ symbol box with description showing 20 different symbols used in Civil Engineering 

discipline. 

4. Using Center Marks and Center Lines, among other basic tools draw the following in AutoCAD 2017. 



NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

Department of Civil Engineering 

Subject Code: CIV-705     Course Title: Computer Aided design (CAD) 

Tutorial 3 

1.  What is machine learning? What are the pros and cons while applying it in Civil Engineering 

problems? 

2. Explain the various steps involved in designing the Artificial Neural Network (ANN) in MATLAB 

software.  

3.  Identify the diagram shown in figure 3.1. Also explain various stages shown. 

 

 

 

 

 

 

 



NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

Department of Civil Engineering 

Subject Code: CIV-705     Course Title: Computer Aided design (CAD) 

Tutorial 4 

1. Draw 20 different blocks which are required time and again in Civil Engineering drawings. Try 

out all the three options (i.e. BLOCK, WBLOCK and dynamic-BLOCK) and analyze the difference 

between the three. 

2. In a new file, draw the following polar array, made up of a table, chairs, and computers. No 

sizing is given and all elements can be approximated. Place each element on the appropriate 

layer, and make a block out of it prior to using it in the array. 

 

 

3. What are the essential settings that need to be set up before printing a drawing in AutoCAD? 

How does  Page Setup Manager make things easier while taking the final output? 



NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

Department of Civil Engineering 

Subject Code: CIV-705     Course Title: Computer Aided design (CAD) 

Tutorial 5 

1. Explain the use of F5-key used in Isometric snap in AutoCAD with the help of an example. 

2. How do we make circles and text so that it looks a part of the isometric drawing in AutoCAD? 

3. Draw the following computer table using isometric snap in AutoCAD. The text however should 

be changed to “National Institute of Technology Srinagar” followed by your name. 

 

 



NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

Department of Civil Engineering 

Subject Code: CIV-705     Course Title: Computer Aided design (CAD) 

Assignment 1 

Q1: In a new file, set up Architectural units, the correct layers (A-Walls, A-Doors, and A-Windows), and 

draw the following floor plan. 

 

Q2: In a new file, set up Architectural units, the correct layers (A-Walls, A-Doors, A-Windows, and A-

Furniture), and draw the following floor plan including the furniture.Those dimensions not expressly 

given (such as with the furniture, kitchen, and bathroom elements and other minor details of the floor 

plan itself) can be assumed and free-drawn to appropriate size. 



NATIONAL INSTITUTE OF TECHNOLOGY SRINAGAR 

Department of Civil Engineering 

Subject Code: CIV-705     Course Title: Computer Aided design (CAD) 

Assignment 2 

Q1: Design a logo for Civil Engineering Departmentin AutoCAD 2017. Apart from using drawing and 

modify toolbar use SKETCH and 

ARCTEXT commands. 

Q2: Open a new file, create the 

appropriate layers, and set units to 

Architectural. Create the stair (shown 

in figure) layout and hatch patterns. 

Any sizes and dimensions that are not 

given can be estimated, as can the 

scale of the patterns. Add in text 

where needed. 

 

 

 

 

 

Q3: Create the following architectural 

detail. Many (but not all) of the 

dimensions are given. Use them as a 

basis to size the rest. Then, approximate 

the hatch patterns as shown. The 

squiggly vertical one is not a hatch 

pattern but a LINETYPE, called Batting, 

often used to show insulation. Adjust its 

LTSCALE until it looks like what is shown. 

 

 



Machine Learning 
Technique– Artificial 

Neural Network

1



2

Machine learning is a data analysis technique that teaches
computers to do what comes naturally to humans and animals:

What Is Machine Learning ?

Learn from Experience



Supervised learning:
Trains a model on
known input and
output data so that it
can predict future
outputs.

Machine Learning Techniques

Unsupervised
learning: Finds
hidden patterns or
intrinsic structures in
input data.

3



Artificial Neural Network

X2

X1

Nucleus

Dendrites

Axon
Synapse

Y

X1

X2
Y

Input Layer

Hidden Layer

Out Layer

Biological Neuron Artificial Neural Network

A biological neuron basically collects

the sensed information of different

strengths and passes it on to

subsequent neurons, if it compares

with a stored threshold.

An artificial neuron

tries to mimic this.

The inputs X1, X2, etc may

come from system variables

or outputs of other nodes.

Weights

The summing node/hidden layer

accumulates all weighted input signals

after adding or subtracting a bias value

from it and then passes the result

through a transfer function.

4
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Types of Artificial Neural Networks:

Multilayer networks

Classification based on number of layers:

Single layer networks

Bilayer networks
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Working of an Artificial Neural Network:

The goal of ANN is to generalize a relationship of the form:

)( nm XfY = Where :

• Xn is a n dimensional input vector consisting
variables, x1…xi…xn.

• Ym is a m dimensional output vector consisting of
resulting variables of interest, y1…yi…ym.

• The function f is called an activation function. Its
functional form determines the response of the
node to the total input signal it receives.

• The most commonly used form of f is the sigmoid
function, given as :

te
tf

−+
=

1

1
)( Where t =  (X1W1+X2W2+….) + 

(bias) 



Network Training

Training is a process in which the weights are adjusted such that the error (actual Output –

network output) is less than a prescribed value.

Supervised training Unsupervised training

w

w

w O

In
p

u
ts

O
u

tp
u

t

The network processes the
inputs and compares its
resulting outputs against the
desired outputs.

The training sets do not include
solutions and hence the network is left
to learn by itself in the process of
training. This is often referred to as self-
organization or adaptation.

Ow

Errors are then propagated back through the system,
causing the system to adjust the weights, which control
the network. This process occurs over and over as the
weights are continually tweaked until a desired level of
accuracy is reached. This is also called Back Propagation
Algorithm.

w

w

In
p

u
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O
u

tp
u

t
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MATLAB

MATLAB (matrix laboratory) is a numerical
computing environment and programming
language developed by MathWorks.
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Artificial Neural Network

Network with Purelin transfer function 
(NNp) 

Network with Tansig transfer function
(NNt)

Network with Logsig transfer function 
(NNl) 
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Data Normalization in MATLAB 7.0.1

The function “premnmx” is used to scale
inputs and targets so that they fall in the
range [-1, 1]. The following code illustrates
the use of this function.

[pn,minp,maxp,tn,mint,maxt] = premnmx(p,t)

p = input matrix
t= target matrix
maxp= maximum value of input
minp= minimum value of input
maxt= maximum value of target
mint=minimum value of target
pn= normalized input matrix
tn=normalized output matrix

View of the files generating while pre-
processing using “premnmx”command
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Artificial Neural Network

1. Creating the Network:  



Creating the Network:  

Artificial Neural Network 12
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Artificial Neural Network

Creating the Network:  
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Artificial Neural Network

Creating the Network:  



15

Artificial Neural Network

2. Training the Network 
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Artificial Neural Network

2. Training the Network 
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Artificial Neural Network
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Post Training Analysis 

Artificial Neural Network
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Artificial Neural Network

Post Training Analysis 
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Post Training  Analysis:

Artificial Neural Network

In order to convert the
normalized outputs back
into the same units that
were used for the original
targets, “postmnmx” was
used.

On = sim(net,pn);
O = postmnmx(on,mint,maxt);

Where,
On= normalized output
O= un-normalized output
net= network

COMPARISON OF PREDICTABILITY OF MODELS

The results obtained by NNp,
NNt, NNpt and NNtp were
compared by means of Mean
Square Error (MSE), Root
Mean Squared Error(RMSE),
Absolute Average
Deviation(AAD) % and R2 .

Where

n = No. of observations
yp = predicted value obtained from the model
ya = actual value
ym = average of actual values

The model having minimum
MSE, RMSE and AAD and
with maximum R2 is
considered as the best
model.
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Results and Discussions

Post Regression Analysis:

COMPARISON OF PREDICTABILITY OF MODELS

The results obtained by MLR were compared with
those obtained by NNp, NNt, NNpt and NNtp on the
basis of values of MSE, RMSE, R2 and AAD%.
The values of these parameters for the five models
are given in Table below:

S.NO. MODEL NAME MSE RMSE R SQUARE AAD%

1 MLR 0.0204946 0.1431594 0.830458 27.76616

2 NNp 0.020656 0.143721 0.829124 33.97264

3 NNt 0.009394 0.096922 0.922289 20.7275

4 NNpt 0.020656 0.143721 0.829125 33.97264

5 NNtp 0.008899 0.094336 0.926381 30.01107
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Post Regression Analysis:

COMPARISON OF PREDICTABILITY OF MODELS

NNt model gave minimum value of  
AAD% as 20.7275%.

Fig 6.11: Comparison of the various models for flood prediction in 

river Jhelum based on their MSE values

0

0.005

0.01

0.015

0.02

0.025

MSE

M
S

E
 V

a
lu

e
s MLR

NNp

NNt

NNpt

NNtp

Fig 6.12: Comparison of the various modles for flood prediction in 

river Jhelum based on their RMSE values

0

0.02

0.04

0.06

0.08

0.1

0.12

0.14

0.16

RMSE

RMSE values

MLR

NNp

NNt

NNpt

NNtp

NNtp model gave least values
of RMSE as 0.094336

NNtp model gave least
values of MSE as 0.008899

Fig 6.13: Comparison of the various models for flood prediction in 

river Jhelum based on their R-Square values
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NNtp model gave maximum
value of R2 as 0.926381.

Fig 6.14: Comparison of the various models for flood prediction in 

river Jhelum based on their AAD% values
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VALIDATION OF THE FLOOD PREDICTION MODELS
Fig 6.10: Comparison of Flood Prediction Models for Accuracy of 

Results: Actual Discharge v/s Predicted Discharge
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Assignment: 

1. Applications of MATLAB.
2. Neural Network Applications in modeling Civil Engineering problems.
3. Advantages and Limitations of Artificial Neural Networks.
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You
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